
Программы	симуляторы стали неза	

менимыми помощниками разработчи	

ков электронных устройств. С появле	

нием компьютеров появилась возмож	

ность обрабатывать большие массивы

данных и рассчитывать сложные фор	

мулы, которые описывают процессы,

протекающие в схеме устройства. В

настоящее время существует целый

ряд моделирующих программ, и прак	

тически все они созданы на основе

SPICE, которая была разработана в уни	

верситете Беркли. Программа PSpice

считается образцом схемотехническо	

го моделирования и используется раз	

работчиками всего мира чаще, чем все

остальные программы вместе взятые.

Модуль Mixed SIM комплексной систе	

мы Altium Designer является полнофу	

нкциональным аналогом пакета

PSpice.

При моделировании аналоговых

устройств в Altium Designer использу	
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Altium Designer –
схемотехническое моделирование
и типы моделей

Алексей Сабунин (Москва)

В процессе разработки радиоэлектронных устройств важное место

занимает схемотехническое моделирование. Большая часть систем,

в которых решается данная задача, работает на основе SPICE;

не исключением является и модуль Mixed SIM в пакете Altium Designer.

В данной статье описаны основные этапы и виды моделирования схемы

в Altium Designer, а также самый сложный этап моделирования –

создание моделей.

ются алгоритмы SPICE 3f5; при моде	

лировании цифровых устройств ис	

пользуется алгоритм XSPICE с описа	

нием моделей цифровых элементов

на языке Digital SimCode. Применяе	

мые в пакете усовершенствованные

алгоритмы моделирования семей	

ства SPICE, положительно зарекомен	

довавшего себя в мировой практике

на протяжении последних 20 лет,

позволяют проводить расчёт широ	

кого класса цифровых, аналоговых

и цифро	аналоговых электрических

схем и обеспечивают хорошую схо	

димость итерационных процессов

при моделировании без дополни	

тельной настройки.

Принципиальная схема моделируе	

мого устройства создаётся с помощью

схемного редактора Altium Designer.

При выборе режима моделирования,

данные о принципиальной схеме (в

виде списка соединений) автомати	

чески передаются в модуль Mixed SIM

для составления задания на модели	

рование, собственно моделирования

и просмотра его результатов. Основ	

ной проблемой при моделировании

является разработка моделей радиоэ	

лементов, особенно отечественных,

поскольку точность построения моде	

ли определяет адекватность модели	

рования.

Достаточно подробные рекоменда	

ции по разработке и использованию

моделей приведены в электронной до	

кументации, входящей в состав Altium

Designer (TR0113 Simulation Models and

Analyses Reference.PDF, AP0141 SPICE

Model Creation from User Data.PDF,

AP0139 Creating and Linking a Digital

SimCode Model.PDF, TR0117 Digital Sim	

Code Reference.PDF).

ЭТАПЫ МОДЕЛИРОВАНИЯ

В СИСТЕМЕ ALTIUM DESIGNER

Несмотря на то что практически все

программы моделирования имеют

примерно одинаковый набор настро	

ек и обязательных действий для симу	

ляции, Altium Designer имеет некото	

рые характерные особенности.

Шаг 1 – создание проекта. Кроме

создания листа схемы, программа тре	

бует обязательного наличия файла

проекта. Создадим новый проект ко	

мандой File > New > Project > PCB Project

и новый лист схемы File > New >

Schematic. Кроме схемы, в структуру

проекта рекомендуется добавить все

библиотеки и модели, которые будут

использованы при создании схемы

(если не используются интегрирован	

ные библиотеки).

Шаг 2 – разработка схемы. На соз	

данном листе схемы размещаются

компоненты и рисуются линии связей.

В рассматриваемом примере последо	

вательно разместим резистор и кон	

денсатор (см. рис. 1), взятые из станда	

ртной библиотеки Miscellaneous De�

vices.IntLib, которая по умолчанию

подключена к системе. Линии связей

размещаются командой Place > Wire.Рис. 1. Пример проекта для моделирования
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Шаг 3 – размещение источников сиг�

налов. Все источники сигналов и пита	

ния, которые могут быть использова	

ны при моделировании схем, распо	

ложены в библиотеках, находящихся

в папке …Library\Simulation в директо	

рии установки программы Altium. В на	

шем случае следует подключить биб	

лиотеку Simulation Sources.IntLib, для че	

го на вкладке DXP > Preferences > System >

Installed Libraries нажимаем кнопку In�

stall и выбираем указанную библиоте	

ку. Установка источников сигналов ни	

чем не отличается от размещения

обычных компонентов.

Шаг 4 – установка параметров

компонентов схемы. В рассматривае	

мом примере в качестве источника

сигнала выступает компонент VSIN,

который расположен в подключенной

библиотеке Simulation Sources.IntLib и

представляет собой источник синусо	

идального сигнала. После установки

источника выполняем на нём двойной

щелчок мыши и в поле Models нажи	

маем кнопку Edit (см. рис. 2). Здесь на

вкладке Parameters указываем пара	

метры источника (амплитуду и часто	

ту сигнала). Аналогично, в свойствах

резистора и конденсатора задаём па	

раметры номинального сопротивле	

ния и ёмкости. Подробно все парамет	

ры компонентов и источников описа	

ны в [1, 2].

Шаг 5 – описание цепи GND. Все про	

цессы моделирования выполняют рас	

чёты относительно некоторого нуле	

вого уровня, в качестве которого в Al	

tium Designer по умолчанию принята

цепь GND. В нашем случае поместим

знак цепи заземления на нижний вы	

вод источника командой Place > Power

Port.

Шаг 6 – именование цепей. Все цепи,

с узлов которых будут сниматься ха	

рактеристики для анализа, следует по	

именовать командой Place > Net Label. В

данном случае на первый вывод резис	

тора устанавливаем метку IN (вход), на

второй – OUT (выход).

Шаг 7 – установка параметров ана�

лиза. Для моделирования использует	

ся специальная панель Mixed Sim, кото	

рая в Altium Designer по умолчанию

скрыта. Чтобы отобразить эту панель в

рабочей области, необходимо нажать

правой кнопкой мыши на любой па	

нели инструментов и в выпадающем

списке указать нужную панель (см.

рис. 3).

В появившейся панели имеются три

кнопки:

● Run Mixed Signal Simulation – запуск

процесса моделирования (клавиша

F9);

● Setup Mixed�Signal Simulation – наст	

ройки моделирования;

● Generate XSpice Netlist – формирова	

ние общей модели схемы (с провер	

кой).

Начальным этапом проектирования

является процесс составления задания

на моделирование, для чего нажатием

кнопки Setup Mixed�Signal Simulation на

экран выводится диалоговое окно

Analyses Setup (см. рис. 4); в нём задают	

ся необходимые виды анализа и выби	

раются схемные переменные (напря	

жения в узлах схемы, токи в цепях схе	

мы, комплексные сопротивления,

рассеиваемые мощности на элементах

схемы) для их сохранения в файле ре	

зультатов и графического отображе	

ния. Виды и параметры анализа указа	

ны в таблице 1.

На вкладке General Setup необходи	

мо указать названия цепей, с которых

необходимо получить сигналы, и в по	

ле SimView Setup выбрать вариант

Show Active Signal. В поле Available Sig�

nals приводится перечень сигналов,

графики которых строятся по резуль	

татам моделирования. Из одного поля

в другое все сигналы переносятся на	

жатием клавиш «>>» и «<<». Выбран	

ные правой кнопкой мыши сигналы

переносятся нажатием кнопок «>» и

«<». Позже, при необходимости, сос	

тав выводимых графиков можно из	

менить.

Дополнительные обозначения в по	

ле Available Signals:

● #branch – ток через источник нап	

ряжения;

● [i] – ток через двухполюсный компо	

нент;

● [р] – рассеиваемая мощность;

● [z] – модуль комплексного сопротив	

ления (равного отношению э.д.с.

сигнала к току через источник сигна	

ла);

● [ib] – ток базы транзистора;

● [ic] – ток коллектора транзистора;

● [ie] – ток эмиттера транзистора.

Остальные настройки здесь следует

оставить по умолчанию. Далее в спис	

ке Analyses/Options выбираем вид ана	

лиза Transient Analysis (анализ переход	

ных процессов). После выбора вида

анализа в правой части окна Analyses

Setup необходимо указать настройки

выбранного вида анализа (см. рис. 4).

Здесь по умолчанию включен пара	

метр Use Transient Defaults, который

предлагает использовать временной

интервал в виде конечного числа пол	

ных периодов входного сигнала. В дан	

ном случае количество циклов равно 5

(Default Cycles Displayed), и в каждом

периоде для расчёта используются

данные в 50 точках (Default Points Per

Cycle). При необходимости можно вык	

лючить параметр Use Transient Defaults

и задать временной интервал модели	

рования с помощью параметров Start,

Stop, Step Time (время начала, оконча	

ния и шага моделирования).
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Рис. 2. Установка параметров сигналов

Рис. 3. Добавление панели Mixed Sim



Шаг 8 – запуск моделирования. Пос	

ле установки параметров нажимаем

кнопку Run Mixed Signal Simulation в ра	

нее открытой панели инструментов. В

итоге на экране будут показаны два

графика, отображающие сигналы в

указанных узлах. Результаты модели	

рования в системе Altium Designer сох	

раняются в отдельный файл с расши	

рением *.SDF, в нижней части которого

показаны вкладки выполненных видов

моделирования.

ВИДЫ МОДЕЛЕЙ

В ALTIUM DESIGNER

Не останавливаясь на методах об	

работки и интерпретации результа	

тов моделирования (см. ниже), вер	

нёмся на начальный этап – создание

схемы. Чтобы перейти к схеме от ре	

зультатов моделирования, необходи	

мо выбрать схему в списке докумен	

тов в структуре панели Project или

выбрать соответствующую вкладку в

верхней части интерфейса. При соз	

дании схемы в нашем случае были ис	

пользованы компоненты, на которые

имелись модели в формате SPICE (см.

рис. 5). Что делать, когда такой моде	

ли нет?

Встроенные модели. Для моделиро	

вания можно использовать модели, со	

держащиеся во внутреннем аппарате

симулятора, внутри интегрированных

библиотек Altium Designer, а также

пользовательские модели компонен	

тов. Рассмотрим назначение моделей

разного типа и особенности их ис	

пользования.

Самыми простыми в использовании

являются модели, встроенные в SPICE,

параметры которых задаются через

интерфейс программы. Для использо	

вания таких моделей необходимо ука	

зать, к какой функциональной груп	

пе относится данный компонент, и за	

дать параметры, характерные для

компонентов данной группы. В рас	

сматриваемом примере, чтобы ука	

зать для резистора встроенную мо	

дель, необходимо зайти в окно

свойств модели (как было показано в

описании источника сигнала и на ри	

сунке 2), которое содержит три вклад	

ки (см. рис. 6):

● Model Kind – описание модели; здесь

указывается одна из встроенных мо	

делей либо дается ссылка на пользо	

вательскую модель;

● Parameters – параметры, которые за	

даются только для встроенных мо	

делей;

● Port Map – установка соответствия

номеров выводов на символе и наз	

ваний выводов в тексте модели; зада	

ётся в основном для пользовательс	

ких моделей.

Чтобы установить пользовательскую

модель, необходимо сначала указать

тип модели в строке Model Kind, затем

из следующего списка выбрать конк	

ретную модель. В строке Spice Prefix по	

является буквенное обозначение мо	

дели (см. таблицу 2), которое определя	

ет набор характерных параметров.

Часть параметров этих моделей дос	

тупны на вкладке Parameters, другие

имеют стандартные значения, которые

во встроенной модели изменять нель	

зя! Описание всех встроенных моде	

лей и параметров приведено в доку	

менте TR0113. Так, для резистора, в ре	

зультате поиска по документу TR0113

фразы «prefix R», будет найдено описа	

ние параметров, где показаны сопро	

тивление (Value), длина, ширина и тем	

пература, а в дополнительных пара	

метрах – линейный температурный

коэффициент (TC1) и др.

Если выбрать встроенную модель, то

при анализе можно изменять лишь

открытые параметры. При использо	

вании пользовательских моделей воз	

никает необходимость более гибко

варьировать параметры модели.

Формат *.MDL. Для создания пользо	

вательских моделей компонентов, ко	

торые имеются среди встроенных мо	

делей, используется формат *.MDL, ос	

нованный на директиве «.MODEL»

языка SPICE. Например, для используе	

мого резистора опишем его темпера	

турную зависимость, которая во встро	

енной модели по умолчанию имеет

значение, равное нулю, т.е. сопротив	

ление резистора не зависит от темпе	

ратуры.

Для создания пользовательской тем	

пературно	зависимой модели резис	

тора выполним File > New > Mixed�Signal

Simulation > AdvancedSim Model. Прог	

ПРОЕКТИРОВАНИЕ И МОДЕЛИРОВАНИЕ

4 WWW.SOEL.RU СОВРЕМЕННАЯ ЭЛЕКТРОНИКА ◆ № 6  2009

Настройки текущего анализа

Настройки моделирования

Рис. 4. Настройки моделирования Рис. 5. Виды моделей SPICE

*.MDL

*.CKT

*.SCB
*.LB   

Встроенные
модели

Модели

Таблица 1. Виды анализа в системе Altium Designer

Вид анализа Описание

Operating Point Analysis
Расчёт режима работы по постоянному току (расчёт «рабочей точки») при линеаризации

моделей нелинейных компонентов

Transient/Fourier Analysis Анализ переходных процессов и спектральный анализ

AC Small Signal Analysis
Частотный анализ в режиме малых сигналов (для нелинейных схем выполняется

в линеаризованном режиме в окрестности рабочей точки по постоянному току)

DC Sweep Analysis
Расчёт режима по постоянному току при вариации одного или двух источников

постоянного напряжения или тока

Noise Analysis Расчёт спектральной плотности внутреннего шума

Transfer Function Analysis Расчёт передаточных функций в режиме малых сигналов

Temperature Sweep Режим изменения температуры

Parameter Sweep Изменение параметров элементов

Monte Carlo Analysis Статистический анализ по методу Монте-Карло
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рамма создаст в структуре текущего

проекта файл с расширением *.MDL, ко	

торый следует сохранить под уникаль	

ным именем, соответствующим назва	

нию компонента. Далее с созданным

файлом работа ведётся в режиме обыч	

ного текстового редактора, где наби	

рается описание модели:

.MODEL RTEMP RES (TC1=0. 2

TC2=0.02),

где: .MODEL – директива описания дан	

ной модели; RTEMP – название поль	

зовательской модели; может иметь

произвольный набор символов, но для

удобства должно совпадать с названи	

ем файла; RES – название встроенной

модели, на которую ссылается пользо	

вательская модель; (TC1=0. 2 TC2=0.02) –

описание параметров пользовательс	

кой модели.

При написании модели нельзя ос	

тавлять пробел перед директивой

«.MODEL». Основная сложность при

создании пользовательских моделей

возникает из	за того, что заранее из	

вестны не все параметры. Чтобы узнать

параметры конкретной модели, необ	

ходимо выполнить поиск её описания

в файле справки TR0113 или просмот	

реть русскоязычные источники [2, 3].

Для использования модели в форма	

те .MDL её необходимо подключить к

компоненту, причём целесообразно

это делать на уровне библиотеки. О

создании библиотек и подключении

моделей было подробно рассказано в

СЭ № 6, 2008. В нашем случае подклю	

чим модель непосредственно к компо	

ненту на схеме. При подключении мо	

дели рекомендуется, чтобы она нахо	

дилась в структуре того проекта, в

котором находится схема или библио	

тека, в зависимости от того, где подк	

лючается модель. Причём, если модель

будет подключена к интегрированной

библиотеке, то после её компиляции

она будет находиться в ней, как в архи	

ве. При подключении модели в схеме,

на неё будет дана только ссылка! В на	

шем случае в свойствах модели резис	

тора (см. рис. 6) на вкладке Model Kind

выбираем тип модели Resistor(Semicon�

ductor), после чего становятся доступ	

ны настройки расположения модели:

● Any – любая модель из проекта и в

подключенных библиотеках;

● In File – любой файл модели, находя	

щийся в директории проекта;

● Full Path – любая модель на диске

компьютера;

● Use SIM from… – модель из интегриро	

ванной библиотеки.

Выбираем вариант Any, после чего

при нажатии кнопки Browse будут дос	

тупны все модели в подключенных биб	

лиотеках и внутри проекта (см. рис. 7).

В выпадающем списке Libraries вы	

бираем созданную модель RTEMP и на	

жимаем кнопку OK во всех открытых

окнах. Теперь проведём рассмотрен	

ный ранее анализ переходных процес	

сов при изменении температуры окру	

жающей среды. Сначала зададим пара	

метры анализа в окне Analyses Setup, ко	

торое вызывается кнопкой Setup Mixed�

Signal Simulation. Здесь необходимо

указать тип анализа Transient Analysis с

параметрами, указанными на рисунке

4, и дополнительно выбрать Tempera�

ture Sweep (режим изменения темпе	

ратуры). Для выбранного режима ус	

танавливаются параметры темпера	
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Соответствие выводов
модели и символа

Параметры
встроенной модели

Описание
модели

Тип и название
встроенной модели

Расположение модели

Рис. 6. Окно свойств модели

Таблица 2. Описание буквенных обозначений встроенных моделей

Spice Prefix Описание компонента

B Арсенид-галлиевый полевой транзистор с каналом n-типа

C Конденсатор

D Диод

E Источник напряжения, управляемый напряжением

F Источник тока, управляемый током

G Источник тока, управляемый напряжением

Н Источник напряжения, управляемый током

I Независимый источник тока

J Полевой транзистор с управляющим р–n-переходом и каналом n-типа

J Полевой транзистор с управляющим р–n-переходом и каналом р-типа

К Магнитный сердечник трансформатора

L Индуктивность

М МОП-транзистор с каналом n-типа

М МОП-транзистор с каналом р-типа

Q Биполярный n–p–n-транзистор

Q Биполярный p–n–p-транзистор

R Резистор

T Линия задержки

V Независимый источник напряжения

S Ключ, управляемый напряжением

W Ключ, управляемый током

X Макромодель



турного диапазона в градусах Цельсия

(см. рис. 8):

● Start Temperature = 30 – нижний пре	

дел изменения температуры;

● Stop Temperature = 50 –  верхний пре	

дел изменения температуры;

● Step Temperature = 10 – шаг измене	

ния температуры.

После запуска моделирования дан	

ной схемы на экран выводится нес	

колько графиков (в соответствии с за	

данными настройками), и на одном из

графиков будут изображены сигналы

при изменяющейся температуре с мет	

ками OUT_t1, OUT_t2 и OUT_t3, которые

показывают значения при заданных

температурах.

При проведении любого вида ана	

лиза программа Altium Designer фор	

мирует отчётный файл (Spice Netlist) с

расширением *.nsx, который для рас	

сматриваемого примера имеет вид, по	

казанный на рисунке 9.

Здесь текстовые поля, начинающи	

еся со знака '*', являются комментарием

и не обрабатываются программой.

Опишем назначение некоторых раз	

делов данного файла:

● *Schematic Netlist. Всю схему прог	

рамма разбивает на простейшие

элементы, которые перечислены в

данном разделе. Для каждого эле	

мента перечислены узлы, которые

подключены к его выводам, а также

параметры элемента и ссылка на мо	

дель. Например, строка «R1 IN OUT

100 RTEMP» говорит о том, что эле	

мент R1 подключен к цепи IN пер	

вым выводом и к цепи OUT вторым

выводом, сопротивление резистора

равно 100 Ом и используется модель

RTEMP;

● *Selected Circuit Analyses. Здесь показа	

ны выбранные виды анализа. В на	

шем случае метка .TRAN означает

анализ переходных процессов, а

метка .CONTROL задаёт температур	

ный разброс;

● *Models and Subcircuits. Список подк	

люченных моделей в формате *.MDL

и *.CKT.

Проведение моделирования воз	

можно без наличия схемы (по списку

соединений). Так, в упрощённом ви	

де можно изменять параметры ком	

понентов в текстовом файле *.nsx и

командой Simulate > Run запускать

процесс моделирования непосред	

ственно из текстового редактора.

Описанную эквивалентную схему в

разделе *Schematic Netlist можно сох	

ранить в виде отдельного файла и ис	

пользовать в дальнейшем как самос	

тоятельное устройство в виде «чёр	

ного ящика». Модель, созданная

таким образом, является моделью

второго уровня и имеет расширение

*.CKT. Описание таких моделей и мо	

делей цифровых микросхем будет

рассмотрено в следующей статье

цикла.
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Рис. 7. Подключение пользовательской модели

Рис. 8. Настройки режима изменения температуры

Рис. 9. Spice Netlist для задания на моделирование




